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Software Orientation 

In this chapter you learn how to: 

• open and close SpecLink, 

• open and view a sample project, 

• use the SpecLink Menu Bar and Toolbars, 

• navigate in both the Tree Panel and the Document Panel, 

• operate the various controls, and 

• access and use Help. 
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Overview 
To prepare a project specification in SpecLink you work in one of two areas of the Project 
Window—the Tree Panel or the Document Panel. SpecLink windows contain many areas 
that are typical to Windows applications, including a Title Bar, Menu Bar, and Toolbars.  

Opening SpecLink 
Open SpecLink by choosing Start, then Programs, then BSD SoftLink Products, and finally 
SpecLink. You can also create a shortcut on your desktop, if desired. Refer to your 
Windows Help for directions. 

When you start SpecLink, an initial title screen appears, closely followed by the Main 
Window. 

 

The SpecLink Main Window 



C h a p t e r  3  :  S o f t w a r e  O r i e n t a t i o n  

 S p e c L i n k  U s e r  M a n u a l  51 

Opening the Sample Project 
For an overview of the SpecLink screens and functions, use the following steps to open the 
sample.spp project that is included with the program. 

1. From the File menu, choose Open Project. Or click the Open Project button on the 
Standard Toolbar. 

 The Recently Used dialog box opens. You can double-click on a file to open it, or click 
Browse, choose the correct drive and directory, and select a file from the list presented. 

2. Click on sample.spp, and then click Open. Or double-click on sample.spp. 

 The SpecLink Sample Project opens.  

 

The Project Window 

3. Click plus signs in the tree to see the lower level folders available in each top level 
folders and the individual sections available under the level 2, 3 or 4 folders. Use the 
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scroll bar to see the complete list.  The folders will change, depending on whether you 
are using the MasterFormat 95 or MasterFormat 2004 hierarchy.  To switch from one 
to the other, open the Summary Info Dialog Box on the File menu. 

 You can also use the Expand Branch and Expand Tree buttons on the Project 
Window Toolbar. 

4. Sections have gray boxes to the left.  Folders have folder icons to the left.  Click on a 
section title (not the gray box) in the Tree Panel. The corresponding section opens in 
the Document Panel. 

 

Project Window with Partly Expanded Tree 

The Project Window 
Below is a view of the SpecLink Main Window with a Project Window open and maximized. 
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SpecLink main window with maximized project window 

In the Project Window, all panels are open in default view. You can change this view at any 
time by resizing or closing any panel, and the current view will be saved when you close 
the project. 

To resize the panels, move the cursor to the horizontal or vertical bar separating any two 
panels. When the cursor changes to a horizontal bar with up and down arrows, or a vertical 
bar with left and right arrows, click and hold the left mouse button to “grab” the bar, then 
drag it to suit your needs. 

To close (and re-open) panels, choose the name of the panel from the View menu. The 
entire left side can be turned on and off altogether by choosing View > Project Tree Panel. 
View > Project Tree turns off the Tree Panel, leaving the Notes panels open. The 
commands in the View menu are toggles. Choose the same command to turn the panel on 
or off. 

Tree Panel: 
Titles of all 
available 
sections 

display here. 

Document Panel: 
Displays content of 

selected section. 

Toolbars 

Project Notes 
Panel 

Master Notes 
Panel 

Menu Bar 
Title Bar 

Status Bar 

Document 
Panel Status 

Columns 
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The panels can also be turned off and on using the following toolbar buttons: 

 Toggle display of Project Tree 

 Toggle display of Master Notes 

 Toggle display of Project Notes 

 Open and close the Project Tree panel 

 Open and close the Document panel 

The Tree Panel 
The Tree panel allows you to navigate through the database to select a section to review or 
edit. The Tree operates like Microsoft Windows Explorer. To open a branch, click on the 
plus sign adjacent to the folder. To close a branch, click the minus sign. To open a section in 
the Document panel, click on the title of the section in the Tree. 

The Document Panel 
The Document panel is where you edit the section content. The panel makes it easy to see 
section organization and components. You can scroll and view master text to determine the 
paragraphs you want to include in your document. In addition to the section content, the 
Document panel includes status columns associated with the content, a horizontal ruler to 
assist with document formatting, and a document formatting toolbar.  

See the "Document Panel" section in this chapter for details about each area of the 
Document panel. 

SpecLink Windows 
The SpecLink windows are designed to make it easy for you to work quickly and efficiently. 
If you have used other Microsoft Windows-based applications, many of the components of 
the windows will be familiar to you. In addition, visual indicators designed especially for use 
in SpecLink help guide you. 

SpecLink windows include the following components: 

Title Bar The top line of the window listing the project name and the section 
that is currently displayed in the Document Panel. 
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Menu Bar Below the Title Bar, the Menu Bar lists the menus available in the 
window. Click the menu name to display the menu commands. 

Toolbars A series of graphical buttons that are shortcuts to commonly used 
functions. Click the icon to access the function. The toolbar buttons 
are listed later in this chapter. 

Toolbar 
Balloons 

Hold the cursor momentarily over the toolbar button to display a 
toolbar balloon that gives an abbreviated functional description. 

Status Bar An area on the bottom of the window that displays information about 
the current operation. 

Scroll Bars Movable bars to the right and bottom of the window that permit 
vertical and horizontal scrolling of contents to view information that 
extends beyond the window edges. 

Window Size 
Controls 

Icons in the upper right of the window used to maximize, minimize, or 
restore window size and close the window. 

More information displays in each window when using higher resolution video cards and 
monitors. Use of a high-resolution display system reduces the need to scroll, and permits 
larger portions of multiple windows to display simultaneously. You can change the size of 
windows themselves by dragging window edges as in other Windows applications. 

SpecLink Menu Bar 
The SpecLink Project Window Menu Bar contains menus for File, Edit, View, Tree, 
Document, Tools, Window, and Help. Each menu is described below. 

 

The SpecLink Project Window Menu Bar 

NOTE: In the Main Window, you see a File and Help menu only. The Menu Bar in the 
Main Window changes when a Project Window is opened, adding the menus for 
Edit, View, Tree, Document, Tools, and Window. Many new menu commands 
are added to the original two menus when a Project Window is open. 

File Menu 
New Project… Use New Project to create a new project. The Create New Project 

dialog box opens with a default template you can use as the basis for 
the new project. See Chapter 4 for directions. 
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Open Project… Use Open Project to open an existing project. The Recently Used 
dialog box opens. Select one, or use the Browse button to locate 
another project. Enter the file name or choose it from the files 
presented, then click Open. 

Close Project Use Close Project to close the current project. If you have more than 
one project open, be certain the one you want to close is the one that 
is currently active. 

Copy Project… Copy Project allows you to reuse previous work. The Select 
Unopened File to be Copied dialog box appears. Choose the project 
to copy, and then click on Open. The Enter Destination File Name 
dialog box appears. It will automatically name it as copy of “project 
name”.  You can enter a different file name or choose an existing 
project to overwrite, then click Save.  

Rename 
Project… 

Rename Project allows you to change the file name without altering 
the Project Name and ID entered in Summary Info. The Select 
Unopened to be Renamed dialog box opens. Choose the project to 
rename, then click Open. The Enter Destination File Name dialog 
box opens. Enter a new file name or choose an existing project to 
overwrite, then click Save. 

Delete Project… Use Delete Project to remove a project from where it is stored. The 
Select Unopened to be Deleted dialog box opens. Choose the 
project file to delete, and then click Open. You are prompted to verify 
the deletion. 

Repair/ 
Compact 
Project… 

Use this command to reduce the project file size and sometimes 
repair a project that is causing errors. Call Technical Support (800-
266-7732) if you have any questions or cannot repair and compact. 
When the command is selected, the Repair and Compact Project 
dialog box opens. Select the file you wish to repair and compact, then 
click on Open. See Chapter 9 for details. 

NOTE: You cannot repair and compact a project that is currently open. 

Repair/ 
Compact 
aecLinkMan 

Use this command only when you are receiving an error that your 
aecLinkMan database is corrupted. See Chapter 9 for details. 

Load from Zip 
File 

This command opens a dialog box that allows you to extract a 
project from a zip file. See Chapter 9 for details. 

Save to Zip File This command allows you to compress an unopened file for the 
purpose of backing it up or emailing it. See Chapter 9 for details. 
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Summary Info In the Project Summary Information dialog box you provide the name 
and ID of the project and you establish your selections for global 
options. See Chapter 4 for details.  

Registration and 
Settings 

Opens the Registration and Settings dialog box, which is where you 
set up or change access to the SpecLink master database, and 
establish the number of concurrent users allowed under your license 
agreement. Use this command to access System Settings. See the 
Installation document available on the SoftLink CD, and from the 
BSD website (www.bsdsoftlink.com), for details about registration 
and changing system settings. 

NOTE: All projects must be closed in order to use Registration and Settings. 

Page Setup… Use Page Setup to establish format parameters for the project, 
including margins, orientation, paper size, and more. See Chapter 8 
for details.  

Print Preview Use Print Preview to view how the current document appears when 
printed with the current settings. To preview a document other than 
the currently active one, choose Print from the File menu. Choose 
the section to preview, and then click Preview. 

Print… Use Print to open the Print Dialog box, where you can choose the 
document or documents you wish to print or preview. To print a 
document other than the currently active one, or to print more than 
one section, choose the project, branch, or section to print, then click 
the Print button. To print or preview other reports, first use the Report 
to Print pull-down list to select the report desired, then click the Print 
or Preview button. See Chapter 8 for details about printing 
documents. 

Recently Used 
Files 

This area of the menu displays recently used project files. You can 
open one of these files by clicking on it. 

Exit Use exit to close SpecLink. 

Edit Menu 

NOTE: The Edit Menu is available only when a Project Window is open. 

Undo Last Edit Use this command to revert the current paragraph to its state 
before you began the most recent edit in that paragraph. This 
command is available only while cursor is still on paragraph being 
edited. Once you move the cursor to another paragraph, or press 
delete or backspace, your edit is saved automatically. 
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Cut The Cut command removes blocked text to Windows clipboard. Or 
if the cursor is blinking in a user added paragraph, the Cut 
command removes the entire paragraph including any 
subparagraphs, notes, target links, and choices. You can also use 
the key combination CTRL+X to cut. 

Copy This command copies the current selection to the Clipboard. Or if 
the cursor is blinking in a paragraph, the Copy command copies 
the entire paragraph including any subparagraphs, notes, target 
links, and choices. You can also use the key combination CTRL+C 
to copy. 

Paste This command pastes the current content of the Clipboard to the 
cursor location. If multiple paragraphs have been copied from a 
word processor, the Import From Clipboard feature is initiated. You 
can also use the key combination CTRL+V to paste. 

Delete Use this command to delete the current selection. If text is blocked, 
the blocked text will be deleted. If the cursor is blinking in an edited 
master paragraph, the edited version of the paragraph will be 
deleted. If the cursor is blinking in a user-added paragraph, the 
entire paragraph including notes, target links, subparagraphs, and 
choices will be deleted.  

NOTE: Cut, Copy, Paste and Delete are also available by clicking on the 
appropriate paragraph using your right mouse button. 

Find… Use Find to locate or replace a particular word or phrase in a 
section. The command opens the Find dialog box. Enter the text 
you want to find in the Find What field, and the replacement text, if 
applicable, in the Replace With field. Choose the direction of the 
search and click on the Match Case modifier, if necessary. Choose 
Find Next to move to the first and subsequent occurrences, 
choose Replace, as applicable, to substitute occurrences with your 
replacement text.  

NOTE: Find searches only the current section and will not find text in 
choices that are not currently visible in the project. 

View Menu 
Compact View In the Document panel, Compact View hides all inactive 

paragraphs (those that will not print).  

Expert View In the Document panel, Expert View hides all paragraphs excluded 
by the user or by links. Unselected text remains visible. 
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Master View In the Document panel, Master View shows all text, regardless of 
status. 

NOTE: Master View is the default view. 

Project Tree 
Panel 

The Project Tree Panel command is a toggle that hides and 
reveals the set of panels of the left side of the screen, including the 
tree and notes panels. If the Document panel is closed, this 
command will switch the view to the Document Panel. 

Document Panel The Document Panel command is a toggle that hides and reveals 
the document panel. If only the document panel is visible, the 
Document Panel command will switch the view to the Project Tree 
Panel. 

Project Tree The Project Tree command is a toggle that hides and reveals the 
tree panel only. Choose this command to hide the tree panel, 
leaving the notes panels visible. Choose it again to turn the tree 
back on. 

Master Notes The Master Notes command is a toggle that hides and reveals the 
master notes panel only. Choose this command to hide the master 
notes panel, leaving the tree and project notes panels visible. 
Choose it again to turn the master notes panel back on. 

Project Notes The Project Notes command is a toggle that hides and reveals the 
project notes panel only. Choose this command to hide the project 
notes panel, leaving the tree and master notes panels visible. 
Choose it again to turn the project notes panel back on. 

Tabs The Tabs dialog box allows you to use tabs within a selected 
area of your document.  This feature can be used when you 
want columns to be aligned but do not need to create a table. 
See Chapter 5 for more information on using the Tabs dialog 
box. 

Links The Links command opens the Links floating window. You can 
resize and move the window to suit your needs. Clicking the Close 
button removes the Links window from the screen, but the next 
time you select the Links command, the window reopens in its 
most recent size and location. 

Show Header/ 
Footer 

This command opens the header/footer dialog box, with tabs that 
allow you to switch between Customize Header and Customize 
Footer. 

Display Layout This command opens a submenu with the following view options: 
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Seq. Number In the Document panel, sequential paragraph numbers are 
assigned to all paragraphs in a section, including those that 
are user-added. Their referential integrity is maintained 
automatically by the software, so these numbers are useful 
when tracking links. The Sequence Number command is a 
toggle. Click to conceal the column with sequence numbers; 
click again to reveal them. 

Paragraph 
Level 

Each paragraph in the Document panel has a hierarchy 
level. This level is graphically indicated in the LVL (Level) 
status column. Click to conceal this column; click again to 
reveal levels. 

Tags 

(SpecLink 
Only) 

In the Document panel, the Tag command toggles on and 
off a column that includes labels for paragraphs of different 
types. These labels, or tags allow information about the 
project to be assembled into special reports. 

NOTE: If you copy a paragraph within SpecLink and paste it into a section, 
its tag will also be copied, along with any notes and links. 

Document 
Links 

This command toggles on and off the DL status column in 
the Document panel. With the DL column open, you can 
create hyperlinks to Word documents and activate 
hyperlinks previously created. See Chapter 10 for detailed 
instructions on creating and using document hyperlinks. 

Show Auto 
Numbers 

This command toggles on and off the display of automatic 
paragraph numbering in the Document panel. When 
documents are previewed or printed, the applicable style is 
applied, including any paragraph numbering, regardless of 
the position of this toggle. If the toggle is on, however, each 
paragraph is automatically numbered in the Document 
Panel as it is selected and becomes active. The default 
position for this toggle is On; toggle it off for faster operation.  

Toolbars Toggle to display or hide the list of toolbars displayed. The default 
toolbars in the Main Window are Standard, Edit, and View, each of 
which can be toggled off or back on. You can also further 
customize your toolbars with the Customize command. 

NOTE: You can rearrange your toolbars to suit your work habits. Click on 
the vertical “handle” at the left end of the toolbar and drag it to its 
new position. 
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Status Bar Toggle to display or hide the Status Bar at the bottom of the Main 
Window.  

Tree Menu 
Up One Level Use this command to move focus to the parent of your current 

location in the tree.  

Down One Level Use this command to move focus to the first child of your current 
location in the tree.  

Folders Use this command to open a submenu that allows you to insert a 
folder, insert a child folder, rename a folder, or delete a user-added 
folder. 

Go To Folder This command gives you an alternative way of navigating in the 
tree, aside from clicking on folders directly. Choosing Go To Folder 
opens a submenu with four options: 1) First Folder moves focus to 
the first folder in the tree; 2) Previous Folder moves focus to the 
previous folder in the tree, 3) Next Folder moves focus to the next 
folder in the tree, and 4) Last Folder moves focus to the last folder 
in the tree, regardless of the current level of expansion.  

Expand Branch Use Expand Branch to open the current branch of the tree to its full 
extent.  

Expand All Use Expand All to open the entire tree to its full extent. 

Expand To This command opens a submenu of levels to which the tree can 
be expanded or contracted: Show 1 Level, Show 2 Levels, Show 3 
Levels, and Show 4 Levels. 

Document Menu 
Add Paragraph The Add Paragraph command inserts a blank paragraph in the 

document at the cursor location, moving current text downward. The 
new paragraph inherits the hierarchy level of the paragraph at the 
original cursor location. To change the hierarchy level, see the last 
group of commands on this menu.  

Restore 
Paragraph 
From Master (or 
Project) 

Available only when cursor is on an edited paragraph, this command 
restores master text when a user-modified paragraph exists. Once 
this option is chosen, the command toggles to Restore Paragraph 
from Project.  

Remove 
Paragraph 

This command deletes a user-added or a user-edited paragraph. In 
the case of an edited paragraph, the master text is restored. In the 
case of an added paragraph, any user-added subparagraphs are also 
deleted. You are asked to verify the deletion before proceeding. This 
may also be used to remove text that is marked within a paragraph. 
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NOTE: Paragraphs in the master database cannot be removed by the user. 
They can be excluded and subsequently hidden by switching to 
Expert View, which conceals excluded text. 

Remove 
Document 
Link… 

This command deletes a document link from the currently selected 
paragraph. Document Links are hyperlinks to Word documents. See 
Chapter 10 for details. 

Insert (or 
Remove) Page 
Break 

Inserts or Removes a page break before the current paragraph. A 
dark line appears in the Document panel above any paragraph that 
has a page break. The paragraph must be active and must not have 
an NP or NS tag in order for the page break to work.  

Choices Opens a submenu of options for user-added choices, including those 
in copied paragraphs, as follows: 

Add Choice Inserts a choice into a user-added or copied paragraph at 
the cursor location and opens a dialog box that allows you 
to pick choice type and provide values for each option. 
There are several choice types available, including 
exclusive multiple choice, inclusive multiple choice, and 
fill-ins.  

Edit Choice Opens a dialog box that allows you to edit a user-added or 
copied choice at the cursor location. You may add new 
options, edit existing options, or delete existing options. 

Remove Choice Deletes a user-added choice from a user-added or copied 
paragraph at the cursor location.  

NOTE: See Chapter 5 for details on choices in user added and 
copied paragraphs. 

Sections Opens a submenu of options for sections, as follows: 

NOTE: All Sections Menu choices are also available by clicking on 
the appropriate folder or section in the Tree Panel and using 
your right mouse button. 

Add New 
Section 

Opens the Add Section to… dialog box, with spaces to enter 
the section number, acronym, and section title. Pressing the 
OK button creates a new section with the number and title 
entered, inserted below the current cursor location in the 
tree. 



C h a p t e r  3  :  S o f t w a r e  O r i e n t a t i o n  

 S p e c L i n k  U s e r  M a n u a l  63 

Add New 
Section From 
RTF File 

Opens the Import From Rich Text Format Documents dialog 
box, which allows you to select a document in Rich Text 
Format (RTF) to import and use as a new section. See 
Chapter 4 for more information. 

Cut Section Prepares selected user-added section for move, in 
preparation for Paste Section into… 

Copy Section Opens the Copy Section for Pasting dialog box, which 
identifies the section to be copied. Clicking on OK prepares 
the selected section for pasting. 

Paste Section 
Into 

Opens the Paste Section into… dialog box, which allows 
you to identify a new section number, acronym, and title for 
the selected user-added section. The pasted location for the 
new section defaults to the current cursor location in the 
Tree Panel.  

Delete Selected 
Section 

Deletes the selected user-added section, after asking you to 
verify the deletion. You cannot delete a master section.  

Show Text 
Levels 

Opens a submenu of options for displaying the number of levels of 
text to display within the Document Panel. Show All Levels shows all 
8 levels of text.  

No 
AutoNumber 

This toggle allows you to turn off or on the AutoNumbering feature for 
the current paragraph or for multiple blocked paragraphs. This feature 
is particularly useful for inserting tables into a section. This menu 
choice is also available on the right mouse button menu. 

Check Out | 
Check In 

Opens a submenu of options for checking sections out and in, 
increasing editing speed. See Chapter 9 for details.  

Check Out 
Document… 

Checks the current section out of the project, suspending 
linking to other sections. This increases editing speed. If the 
project is stored on a drive other than the local drive, editing 
speed is also increased since a copy of the section is 
placed on the local drive while it is checked out. 

Check In 
Document… 

Use to check a section back in when finished editing. 
Available only when you have a section checked out. 

Undo Document 
Check-Out 

Use to discard all edits made in a checked-out section. If 
selected while a section is checked-out, the checked-out 
copy is deleted, and the copy in the project is made 
available again, in the same state as it was before being 
checked-out. Available only when you have a section 
checked out. 



 C h a p t e r  3  :  S o f t w a r e  O r i e n t a t i o n  

64 S p e c L i n k  U s e r  M a n u a l  

Mark Place Use Mark Place to insert a bookmark at your current location in a 
section. You can then move elsewhere in the section and later use the 
Return to Mark command to return to your marked location.  

NOTE: You can have only one marked place in a section at any one time. 

Return to Mark Use Return to Mark to move back to a bookmark placed elsewhere in 
a section using the Mark Place command. If no mark has been set, 
the Return to Mark command is not available. 

Demote This command decreases hierarchy level of a paragraph by one (for 
example, demoting a level 2 paragraph would make it a level 3 
paragraph), unless the change would result in an illegal gap between 
adjacent paragraphs (a level 3 paragraph cannot be followed by a 
level 5 paragraph, for example). 

NOTE: You can also demote or promote a paragraph by clicking the Demote 
or Promote toolbar button while focus is on the paragraph to be 
changed. 

Demote Branch A branch is a paragraph and all of its subparagraphs. This command 
decreases the hierarchy level of all paragraphs in a branch by one, 
unless the change would result in an illegal gap between adjacent 
paragraphs (a level 2 paragraph cannot be followed by a level 4 
paragraph, for example). 

NOTE: You can also demote or promote a group of paragraphs by blocking 
the paragraphs you want to change and clicking the Demote or 
Promote toolbar buttons. 

Promote This command increases hierarchy level of a paragraph by one (for 
example, promoting a level 3 paragraph would make it a level 2 
paragraph), unless the change would result in an illegal gap between 
adjacent paragraphs (a level 5 paragraph cannot be preceded by a 
level 3 paragraph, for example). 

Promote 
Branch 

This command increases hierarchy level of all paragraphs in a branch 
by one, unless the change would result in an illegal gap between 
adjacent paragraphs (a level 4 paragraph cannot be preceded by a 
level 2 paragraph, for example). 
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Tools Menu 
Customize 
Styles 

The Customize Styles command opens a dialog box that allows you 
to change parameters for each text level, including default font and 
size, line spacing, numbering style, and indentation. 

Spell Use Spell to check spelling in the current section. You can also add 
terms to the master dictionary provided with the program. 

Import From 
Clipboard 

Use Import from Clipboard to paste multiple paragraphs into a 
document from another source. SpecLink uses end of paragraph 
markers and indents to identify individual paragraphs and their 
respective hierarchy levels.  

NOTE: Import from Clipboard uses the hierarchy level of the paragraph at 
the cursor location for the first pasted paragraph. 

Import From 
Project… 

This command opens a dialog box that allows you to import one or 
more sections from any other project into the current project. 

Auto-Select 
New 
Paragraphs 

This command is a toggle. When checked (default setting), when you 
add or import new paragraphs they will automatically be selected by 
a checkmark.  

Look for 
Choice Fields 
in Import 

This command is a toggle. If toggle is on, when using Import From 
Clipboard or Add New Section From RTF File (located on Document 
menu under Sections), brackets and greater than and less than signs 
will be used to create new choices in the imported text.  See Chapter 
4 for more information. 

View Updated 
Master 
Paragraph 

Use this command to see updated text if you have elected not to 
update your project. See Chapter 11 for details.  

Update to 
Master 

Use this command to update any section or the entire project to the 
current version of the master if you have not updated your project. 
The command opens the Applying Master Updates to Marked 
Sections dialog box. Use the pull-down list to select a section to 
update, or click on Update Project, and then click the Update button. 
See Chapter 11 for details. 

Update RS 
References 
Only 

This allows you to accept the updates for all Reference Standards 
(tagged RS) in all sections of your project at once, after having 
opened a project with the Do Not Update option. If the menu choice 
is not available on the Tools menu, that means that there are no 
updates to be done for this option. See Chapter 11 for details. 
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Update ML 
References 
Only 

This allows you to accept the updates for all Manufacturer Listings 
(tagged ML) in all sections of your project at once, after having 
opened a project with the Do Not Update option. If the menu choice 
is not available on the Tools menu, that means that there are no 
updates to be done for this option. See Chapter 11 for details. 

Use In-Memory 
Linking 

Leave this checked to temporarily suspend linking to other sections 
while editing in the current section. This makes editing faster. When 
you click on another section, then the links to other sections will be 
implemented. 

Save In-
Memory 
Linking 

Use this command to save work from the current session without 
clicking on another section. 

Rebuild Section 
Links 

Use this command to rebuild section links, particularly after adding 
user links. 

Rebuild Project 
Links 

Use this command to rebuild all links in a project, particularly after 
operations such as adding or moving sections. 

Compare 
Projects 

This command opens a dialog box that allows you to compare two 
projects, showing the differences between them on screen or in a 
printed report. See Chapter 7 for details. 

Table 
Insert Table Use this command to insert a table above the current paragraph. 

Insert Row 
Below 

Use this command to insert an additional row into the table 
below the current row.  

Configure 
Column 

Use this command to change the width and column alignment of 
the current column.  

Set Border… Use this command to add or remove a border for the table.  

Delete Current 
Row 

Use this command to delete the current row.  

Delete Current 
Column 

Use this command to delete the current column.  

Window Menu 
Arrange Icons Use this command to arrange icons for multiple sections or projects 

at the bottom of the SpecLink window.  

Tile Horizontally Use Tile Horizontally to display all open windows horizontally on the 
screen.  
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Tile Vertically Use Tile Vertically to display all open windows vertically on the 
screen.  

Cascade 
Windows 

Use Cascade Windows to overlap all open windows on the screen.  

New Window Use New Window to open a second copy of your current project. This 
is necessary when creating links from one section to another. 

Active Files List A list of open files is displayed at the bottom of the menu, with a 
checkmark indicating the current file. When a section is checked out 
of a project, the section and the project are listed separately.  

Help Menu 
Contents This command displays the Help contents. From the Contents list, 

choose the topic for which you want Help. 

Use Index for 
Help On 

Type or select from the list of topics. 

Search for Help 
On 

Type a keyword to search for in all topics. 

Register 
SpecLink+… 

This brings you to the Registration and Settings dialog box, where 
you can input an Electronic Invoice ID or an Access Key. 

About BSD 
SpecLink+ 

The About BSD SpecLink+ information box appears, displaying the 
version number and other data about SpecLink. 

SpecLink Standard Toolbar 
To help you work more efficiently, SpecLink provides a Standard Toolbar that includes 
buttons for many commonly used commands. 

NOTE: This Standard Toolbar appears in the Main Window. However, most of the 
functions are active and available only when a Project Window is open. 
 

Hold the cursor momentarily over the toolbar button to display a toolbar balloon 
that describes the button function. 

 

 
Create a New 
Project 

Use New Project to start a new project. The Name New 
Project dialog box appears. Enter a file name, and then 
choose OK. 
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Open Project Use Open Project to open an existing project. The Recently 

Used dialog box appears. Enter the file name or choose it 
from the files presented or click on Browse to open a project 
that has not been opened on this computer. Then choose 
Open. 

 
Close Project Click to close the active Project Window.  

 
Reports Setup Click to open the Reports dialog box.  

 
Print Preview Use Print Preview to see how the current section will look 

when actually printed, using current settings. 

 
Import Sections 
from External 
Project 

Opens the Import From Project dialog box, which allows you 
to copy sections from another project into the current project. 
See Chapter 4 for details. 

 
Cut Paragraphs 
or Selected Text 

Cut applies only to user-added paragraphs or to text that is 
blocked in a master paragraph. Select the user-added 
paragraph you want to cut or block the text to remove, and 
then choose Cut to place it on the Clipboard.  

 
Copy Paragraphs 
or Selected Text 

This command copies the current paragraph (and any 
subparagraphs) and puts it on the Clipboard, with all 
embedded choices. If you have blocked text in a paragraph, 
Copy places a copy of only the blocked text on the Clipboard. 

 
Paste Paste inserts contents from the Clipboard at the designated 

position.  

 
Undo Use this command to revert the current paragraph to its state 

before you began the most recent edit in that paragraph. This 
command is available only while cursor is still on paragraph 
being edited. Once you move the cursor to another 
paragraph, or press delete or backspace, your edit is saved 
automatically. 

 
Find Use Find to find text in the current section. The Find dialog 

box opens. Enter the text to find, the type of search you want 
to perform, and the direction of the search. Then choose Find 
Next. 

 
Spell Use Spell to check spelling in the current section. You can 

also add terms to the master dictionary provided with the 
program. 

 
Open the 
database 
Summary Info 
dialog 

This button opens the Project Summary Info dialog box, 
where you provide the name and id of the project and 
establish your selections for global options. 
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Registration and 
Settings 

Opens the Registration and Settings dialog box, which is 
where you set up or change access to the SpecLink master 
database, and establish the number of concurrent users 
allowed under your license agreement. Use this command to 
access System Settings. See the Installation document 
available on the SoftLink CD, and from the BSD website 
(www.bsdsoftlink.com), for details about registration and 
changing system settings. 

NOTE: All projects must be closed in order to use Registration and Settings. 

 
Page Setup This button opens the Page Setup dialog box, which is also 

available from the File menu. This dialog box allows you to set 
margins, select paper size and orientation, and select options 
such as two-column layout and alternate left/right margins. 

 
Customize Styles This button opens a dialog box that allows you to change 

parameters for each text level, including default font and size, 
line spacing, numbering style, and indentation. 

 
Compare 
Projects… 

This button opens a dialog box that allows you to compare two 
projects, showing the differences between them on screen or 
in a printed report.  

 
Open New 
Window 

Use Open New Window to open a second copy of your 
current project.  

 
Tile Windows 
Horizontally 

Use Tile Windows Horizontally to display all open windows 
stacked horizontally on the screen. 

 
Tile Windows 
Vertically 

Use Tile Windows Vertically to display all open windows in a 
side-by-side arrangement on the screen. 

 
Stack Windows 
in Cascade 

Use Cascade Windows to display all open windows on the 
screen in an overlapping fashion, so a portion of each window 
is visible. 

 
Open Help To 
Contents 

This button opens to the SpecLink Help Contents and Index, 
which allow you to pick a topic or enter a keyword or phrase. 

NOTE: The Standard Toolbar can be toggled off altogether from the View menu, and it 
can also be customized. 
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View Toolbar 
NOTE: This View Toolbar appears in the Main Window. However, none of the functions 

are active and available until a Project Window is open. 
 

Hold the cursor momentarily over the toolbar button to display a toolbar balloon 
that describes the button function. 

  

 
Compact View In the Document Panel, Compact View hides all paragraphs that 

are inactive (those that will not print). 

 
Expert View In the Document Panel, Expert View hides all paragraphs that 

have been excluded by the user or by links. Both selected and 
unselected paragraphs remain visible. 

 
Master View In the Document Panel, Master View shows all text, regardless of 

status. 

NOTE: Master View is the default view. You must be in Master View showing all 
levels of text in order to add, paste, or delete paragraphs. 

 
Toggle display 
of Project Tree 

This button is a toggle that hides and reveals the tree panel only. 
Choose this command to hide the tree panel, leaving the notes 
panels visible. Choose it again to turn the tree on. 

 
Toggle display 
of Master Notes 

This button is a toggle that hides and reveals the master notes 
panel only. Choose this command to hide the master notes 
panel, leaving the tree and project notes panels visible. Choose it 
again to turn the master notes panel on. 

 
Toggle display 
of Project Notes 

This button is a toggle that hides and reveals the project notes 
panel only. Choose this command to hide the project notes panel, 
leaving the tree and master notes panels visible. Choose it again 
to turn the project notes panel on. 

 
Links The Links button opens the Links floating window. You can resize 

and move the window to suit your needs. Clicking the Close 
button in the links window removes it from the screen, but the 
next time you click on the Links button, the window reopens in its 
most recent size and location. 

 
Show Header 
Footer 
Information 

This command opens the header/footer dialog box, which allows 
you to tab between a Customize Header dialog and a Customize 
Footer dialog. Your customized header and footer are applied to 
all documents in the project. 
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Display 
Sequence 
Numbers 

In the Document Panel, sequential paragraph numbers are 
assigned to all paragraphs in a section, including those that are 
user-added. Their referential integrity is maintained automatically 
by the software, so these numbers are useful when tracking links. 
The Sequence Number button is a toggle. Click to conceal the 
status column with sequence numbers; click again to reveal 
them. 

 
Show Tags 

(SpecLink Only) 

In the Document Panel, the Tag button toggles on and off a 
status column that includes labels for paragraphs of different 
types. These labels, or tags, allow information about the project to 
be assembled into special reports. 

 
Show Auto 
Numbers in 
document panel 

This button toggles on and off the display of automatic paragraph 
numbering in the Document panel. If the toggle is on, as each 
paragraph is selected and becomes active, it is automatically 
numbered in the Document panel as it will preview and print. If it 
is off, numbering is not shown in the Document panel, but is 
applied when previewed or printed. The default position for this 
toggle is on; toggle it off for faster operation.  

Edit Toolbar 
NOTE: This Edit Toolbar appears in the Main Window. However, none of the functions 

are active and available until a Project Window is open. 
 

Hold the cursor momentarily over the toolbar button to display a toolbar balloon 
that describes the button function. 

  

 
Add Paragraph This button inserts a blank paragraph in the document at the 

cursor location, moving current text downward. The new 
paragraph inherits the hierarchy level of the paragraph at the 
original cursor location. To change the hierarchy level, click on 
the Demote or Promote buttons on the Document Panel toolbar. 

 
Delete 
paragraphs or 
selected text 

If the cursor is blinking in a paragraph, this button deletes a user-
added or a user-edited paragraph. In the case of an edited 
paragraph, the master text is restored. In the case of an added 
paragraph, any user-added subparagraphs are also deleted. You 
are asked to verify the deletion before proceeding. If text is 
blocked prior to clicking this button, the blocked text is deleted. 

 
Mark Place Use Mark Place to insert a bookmark at your current location in a 

section. You can then move elsewhere in the section and later 
use the Return to Mark command to return to your marked 
location.  
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NOTE: You can have only one marked place in a section at any one time. 

 
Return to Mark Use Return to Mark to move back to a bookmark placed 

elsewhere in a section using the Mark Place command. If no 
mark has been set, the Return to Mark command is not 
available. 

 
Add Choice This button inserts a choice into a user-added or copied 

paragraph at the cursor location and opens a dialog box that 
allows you to pick choice type and provide values for each 
option. There are several choice types available, including 
exclusive multiple choice, inclusive multiple choice, and fill-ins.  

 
Edit Choice This button opens a dialog box that allows you to edit a user-

added choice at the cursor location. You may add options, edit 
existing values, or delete existing options. To change the choice 
type, first remove the choice, and then add a choice of the type 
desired at the same location.  

 
Remove Choice This button deletes a user-added choice from a user-added 

paragraph at the cursor location. 

 
Insert (or 
Remove) Page 
Break 

Inserts or Removes a page break before the current paragraph. 
A dark line appears in the Document above any paragraph that 
has a page break. The paragraph must be active and must not 
have an NP or NS tag in order for the page break to work. 

 
View Updated 
Master 
Paragraph 

Use this command to see updated text if you have elected not to 
update your project. See Chapter 11 for details. 

 
Update Section 
or Project to 
Master 

Use this command to update any section or the entire project to 
the current version of the master if you have not updated your 
project. The command opens the Applying Master Updates to 
Marked Sections dialog box. Use the pull-down list to select a 
section to update, or click on Update Project, and then click the 
Update button. See Chapter 11 for details. 

 
Check-out 
current 
document for 
local editing 

Checks the current section out of the project, suspending linking 
to other sections. This increases editing speed. If the project is 
stored on a drive other than the local drive, editing speed is also 
increased since a copy of the section is placed on the local drive 
while it is checked out. 

 
Merge the 
edited 
document back 
into project 

Use to check a section back in when finished editing. Available 
only when you have a section checked out. 
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Project Window Toolbar 
The Project Window Toolbar includes buttons as shown below: 

NOTE: Hold the cursor momentarily over the toolbar button to display a toolbar balloon 
that describes the button function. 

 
Move Up One 
Level 

This button moves you to the parent of your current section in 
the tree hierarchy.  

 
Move Down One 
Level 

This button moves you to the first child of your current section in 
the tree hierarchy.  

 
Expand Branch This button expands completely the current branch in the tree 

hierarchy.  

 
Expand Tree 
Completely 

Use this button to expand the entire tree to its full extent, 
showing all sections at all levels. 

 
Show Level 

Use Show Level to expand and collapse folders in the Tree 
Panel. Click on the arrow to pull down a list of levels and click on 
the tree expansion level desired. For example, choose Expand 1 
Level to collapse the Tree to show only the division folders. 

 
Open and close 
the Project Tree 
panel 

This button toggles the Tree Panel open and closed. If the 
Document Panel is closed when Toggle Tree Panel On/Off is 
clicked, the Tree Panel closes and is replaced by the Document 
Panel. 

 
Open and close 
the Document 
panel 

This button toggles the Document Panel open and closed. If the 
Tree Panel is closed when Toggle Document Panel On/Off is 
clicked, the Document Panel closes and is replaced by the Tree 
Panel. 

 
Show Level 1-Show 
Level 3 

These three buttons expand or collapse the current section in 
the Document Panel to the specified hierarchy level. For 
example, the Show Level 3 button shows all paragraphs with 
hierarchy levels 0 through 3 and conceals all paragraphs of 
levels 4 through 8. 

 
Show All Levels Use this button to expand the current section in the Document 

Panel to its full extent, showing all paragraphs.  

 
Move to First 
Paragraph 

Clicking this button moves the cursor to the top of the document 
in the Document Panel, regardless of the current cursor location. 

 
Previous 
Paragraph At 
Current Level 

Clicking this button moves the cursor to the immediately 
preceding paragraph of the same hierarchy level in the 
Document Panel. For example, if the cursor is on an article title, 
this button moves the cursor to the previous article title. 
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Next Paragraph 
At Current Level 

Clicking this button moves the cursor to the immediately 
following paragraph of the same hierarchy level in the Document 
Panel. For example, if the cursor is on PART 1 GENERAL, this 
button moves the cursor to the PART 2 PRODUCTS. 

 
Move to Last 
Paragraph 

Clicking this button moves the cursor to the last paragraph in the 
document, END OF SECTION. 

Right Mouse Button Menu – Tree Panel 

 

 Add New 
Section 

Using your right mouse button, choosing Add New Section will 
add a new section from the section template under the currently 
highlighted folder or section in the Project Tree. See Chapter 4 
for details. 

 Add New 
Section from 
RTF File 

Using your right mouse button, choosing Add New Section From 
RTF File will add a new section from your selected RTF file 
under the currently highlighted folder or section in the Project 
Tree. See Chapter 4 for details. 

 Cut Section Using your right mouse button, choosing Cut Section will select 
the currently highlighted (User Added) section in the Project 
Tree and allow you to follow it with the Paste Section Into 
command, as a way to move your section to another folder in 
your project.  

 Copy Section Using your right mouse button, choosing Copy Section will select 
the currently highlighted section in the Project Tree and allow 
you to follow it with the Paste Section Into command, as a way to 
copy this section in your project. 

 Paste Section 
Into 

Using your right mouse button, choosing Paste Section Into will 
paste the previously Cut or Copied Section under the currently 
highlighted folder or section in the Project Tree.  

 Delete Selected 
Section 

Using your right mouse button, choosing Delete Selected 
Section will remove the currently highlighted user added or 
copied section in the Project Tree. 
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Right Mouse Button Menu – Document Panel 

 

 Add Paragraph Using your right mouse button, choosing Add Paragraph will 
insert a new paragraph above the currently highlighted 
paragraph. 

 Cut Using your right mouse button, Cut applies only to user-added 
paragraphs or to text that is blocked in a paragraph. Select the 
user-added paragraph you want to cut or block the text to 
remove, and then choose Cut to place it on the Clipboard. 

 Copy Using your right mouse button, this command copies the 
current paragraph (and any subparagraphs) and puts it on the 
Clipboard, with all embedded choices. If you have blocked text 
in a paragraph, Copy places a copy of only the blocked text on 
the Clipboard.  

 Paste Using your right mouse button, Paste inserts contents from the 
Clipboard at the designated position.  This can be complete 
paragraphs or blocked text, depending in where your cursor is 
positioned. 

 Delete Using your right mouse button, if the cursor is blinking in a 
paragraph, this menu choice deletes a user-added or a user-
edited paragraph. In the case of an edited master paragraph, 
the master text is restored. In the case of an added paragraph, 
any user-added subparagraphs are also deleted. You are 
asked to verify the deletion before proceeding. If text is blocked 
prior to clicking this button, the blocked text is deleted.  

 No 
AutoNumber 

Using your right mouse button, clicking on a paragraph or 
highlighting a group of paragraphs, and then choosing this 
command will suppress the auto-numbers for these paragraphs. 

Tree Panel 
The Tree panel displays the relationships between the hierarchically organized documents 
that comprise the project database and indicates the status of each document. At the top of 
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the panel is the project name. Below that are the level one folders. A plus sign to the left of 
the folder icon indicates there are hidden subfolders below. To see the subfolders, click on 
the plus sign, which becomes a minus sign. To conceal the lower level folders again, click 
on the minus sign. Folders that do not contain subfolders or sections are not preceded by a 
plus or minus sign. 

 

Project Window Tree panel using MasterFormat 95 

To see the document in the Document panel, click on the section title. When you are 
viewing a section, the parentheses following the section name will update to say the section 
is “in use” by you. In a multi-user installation, others who are editing the same project will 
see the section that you are editing listed in gray type in the Tree panel along with the “in 
use by” information. They will be able to click on the name of the section and view it, but 
they will not be able to edit the section. 
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Project Window Tree panel using MasterFormat 2004 

To include a section in your project, click on the status box that precedes the title. To 
exclude a previously selected section, click again on the status box. To expand the tree to 
show all documents through a particular level, click on the Show Level drop-down on the 
Project Window toolbar to pull down a list of document levels, then click on the desired 
level. To expand the tree completely, click the toolbar button Expand Tree Completely. 



 C h a p t e r  3  :  S o f t w a r e  O r i e n t a t i o n  

78 S p e c L i n k  U s e r  M a n u a l  

Document Organization using MasterFormat 95 
The MasterFormat 95 master specification database is divided into folders that correspond 
to CSI’s 16 Divisions, plus Introductory Information (00 documents). These main folders in 
turn are divided into Broadscope Heading folders, each of which corresponds to a 
MasterFormat number and title. Available sections related to each heading are organized 
under each of these Broadscope folders. They are arrayed in numerical order, using a 5-
digit section number and title based on the 1995 MasterFormat published by The 
Construction Specifications Institute (CSI). 

 

SpecLink Main Organization using the MasterFormat 95 hierarchy 

The Division folders contain Broadscope Heading folders corresponding to all the 
broadscope listings in the 1995 MasterFormat.   

 

Division and Broadscope Heading Folders in SpecLink 

Broadscope Heading 
Folders 

Division Heading 
Folder 
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The Broadscope Headings, in turn, are parents to the sections that relate to each heading, 
as illustrated: 

 

Portion of Tree showing sections under a Broadscope heading folder 

NOTE: The specification sections, under their respective Broadscope Heading folder, 
are descriptive specifications organized according to CSI’s 1995 
MasterFormat™. 

Broadscope 
Heading Folder 

 

Sections 
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Document Organization using MasterFormat 2004 
Each MasterFormat number and title defines a “section,” arranged in “levels” depending on 
their breadth of coverage. The broadest collections of related construction products and 
activities are level one titles, otherwise known as “divisions.” Each division in the 
MasterFormat 2004 Edition: Numbers and Titles is made up of level two, level three, and 
occasionally level four numbers and titles assigned by MasterFormat, each of which 
delineate a gradually more detailed area of work results to be specified. Work results are 
defined as traditional construction practices that typically result from an application of skills 
to construction products or resources. A further explanation of how to use each of the 
individual titles listed in MasterFormat 2004 Edition: Numbers and Titles is provided in the 
complete MasterFormat 2004 Edition publication, available from CSI. 

 

Partial display of SpecLink Organization using the MasterFormat 2004 hierarchy 
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Document Organization using PerSpective 
The organization of PerSpective’s performance requirements is based upon UniFormat™, 
modified to better define project requirements hierarchically. UniFormat is in general use in 
the construction industry, especially by cost estimators. One indication of its acceptance by 
the construction industry is its joint promotion by The Construction Specifications Institute 
(CSI), Construction Specifications Canada (CSC), and the American Society for Testing 
Materials (ASTM). UniFormat offers users a logical approach to considering the 
performance and quality of a facility before the design of its elements has been completed. 

The performance specifications begin with Chapter 111, under Performance Requirements, 
and continue through the System Groups, Assemblies, and Elements sections that are 
organized according to UniFormat™. Each section is identified by an alphanumeric section 
number and title. 

 

Partial display of PerSpective Organization using the UniFormat hierarchy 
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Document Organization using Short Form 
The descriptive short form specifications are organized according to MasterFormat 95 as 
published by CSI. The chapter headings for descriptive specifications are illustrated below. 

 

Short Form Specifications using the MasterFormat 95 hierarchy 

Document Panel 
The Document panel is the portion of the Project Window where the content of the 
document is displayed and edited. To display a document in the Document Panel, click on 
the name of the section in the Tree panel. 

Each specification section is organized consistently using CSI’s three-part format: Part 1 -- 
General, Part 2 -- Products, and Part 3 -- Execution. Articles under each of these major 
parts, in turn, are organized consistently with CSI’s SectionFormat™. 

NOTE: Keep in mind that you cannot modify the SpecLink master database directly. You 
can modify it only by information you place in your project overlay. As a result, 
you always have a complete database foundation upon which to generate new 
projects. 
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Project Window Document Panel 

The Document panel is divided into a formatting toolbar at the top, status columns to the 
left, and document text to the right. Scroll bars to the right and at the bottom allow you to 
move through the document. You can also use the Show Level buttons and the Move To 
buttons on the Project Window toolbar to navigate within the document. 

In the document content portion of the panel, each paragraph is one field in a database 
record, as indicated by the sequence numbers in the "#" status column to the left of the text. 
The other status columns display information such as hierarchy level and indicate the 
attachment of master or project notes to the paragraph. 

Document Panel Toolbar 
The Document Panel toolbar includes controls as shown below. A horizontal ruler below the 
Document Panel toolbar is useful for verifying margins and setting tabs in the document. 

NOTE: Hold the cursor momentarily over the toolbar button to display a toolbar balloon 
that describes the button function. 

Document Panel Toolbar 

Document Panel Status Columns 

Document 
Paragraphs 
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Displays level of 
selected paragraph 

The field shows the hierarchy level of the current paragraph and 
thereby indicates the default style that will be applied if the 
paragraph is selected. Use the Promote and Demote 
commands to change the level. 

 
Sets or displays font of 
selected text 

The field shows the font at the current cursor location. To change 
the font for some text, block the text that you want to format, click 
on the arrow to pull down the complete list of fonts available on 
your computer and click on the font you want. If you want to 
change the font for a particular word or phrase only, first block 
the text you want to change before clicking on the new font. 

 
Font Size 

The window shows the font size at the current cursor location. To 
change the font size for some text, block the text that you want to 
format, click on the arrow to pull down the complete list of font 
sizes available on your computer and click on the font size you 
want or type in a replacement size. If you want to change the 
font size for a particular word or phrase only, first block the text 
you want to change before clicking on the new font size. 

 
Bold, Italic, Underline 

These three buttons allow you to change the font style for any 
text you select. If you want to change the style for a particular 
word or phrase, first block the text, and then click on the style 
button or buttons you want.  

 
Align Left, Center, Align 
Right, Justify 

These four buttons allow you to change the alignment of a 
paragraph. Align Left starts every line in a paragraph at the left 
margin. Center balances each line in the paragraph on a vertical 
centerline halfway between the left and right margins. Align Right 
adjusts each line so that it ends at the right margin. Justify 
adjusts each line to align on both the left and right margins. 

NOTE: When you block the text to change the font, font size, apply bold, italic, or 
underline, or change the alignment, you can only apply these to one 
paragraph at a time. To change the default formats of all paragraphs at a 
particular level, from the Tools menu choose Customize Styles to open the 
Styles dialog box. Click the Font tab to format fonts. See the chapter on 
printing for more information about the Styles dialog box. 

 
Demote This command changes the hierarchy level of the current text. If 

your cursor is in a paragraph, Demote moves down only the current 
paragraph by one hierarchy level. If you have blocked one or more 
paragraphs, the command demotes only the blocked paragraphs. 
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NOTE: Promote and Demote will not work if they would create an illegal hierarchy 
gap between adjacent paragraphs. 

 
Demote 
Branch 

This command decreases the hierarchy level of all paragraphs in a 
branch by one, unless the change would result in an illegal gap 
between adjacent paragraphs (a level 2 paragraph cannot be 
followed by a level 4 paragraph, for example). 

 
Promote This command changes the hierarchy level of the current text. If 

your cursor is in a paragraph, Promote moves up only the current 
paragraph by one hierarchy level. If you have blocked one or more 
paragraphs, the command promotes only the blocked paragraphs. 

 
Promote 
Branch 

This command increases hierarchy level of all paragraphs in a 
branch by one, unless the change would result in an illegal gap 
between adjacent paragraphs (a level 4 paragraph cannot be 
preceded by a level 2 paragraph, for example). 

 
Border Clicking on the arrow pulls down a submenu of border options. If 

your cursor is on a paragraph, clicking on any of the border options 
applies the border type to that paragraph. The shadow option 
applies only if you have also selected one of the other border 
options. 

 
Tags 

(SpecLink 
Only) 

The button displays the tag applied to the current paragraph. If there 
is no tag applied to the paragraph, it displays NA. To apply a new or 
different tag, click the dropdown arrow and choose the desired tag 
from the list. 

The ruler below the Document Panel toolbar is useful for establishing tabs for a particular 
paragraph or a group of blocked paragraphs, overriding the established style for the 
particular hierarchy level. To set tabs, click on the ruler at the desired locations. Delete tabs 
using your right mouse button. You can also change the margins for a particular paragraph 
by dragging the margin markers to the desired locations. 

NOTE: To change margins for the entire project, go to the File menu and click on Page 
Setup. To change indentation, line skipping, and other formatting features, click 
on the Tools menu and select Customize Styles to open the Styles dialog box. 
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Document Panel Status Columns 
You can choose to show or hide various status columns in the Document Panel. 

Sequence No (#): 
This is a system-assigned sequential number for locating text. The 
sequence number is useful for determining when text is hidden. In 
Compact and Expert views, non-printing or excluded text is 
concealed, and as a result, gaps occur in the numbering. Also, if the 
section is not fully expanded, text at lower levels is concealed, 
resulting in numbering gaps. Sequence Number is also useful for 
locating link targets and link sources. This column can be toggled off 
and on (the default position is On).  
Note: A green background in the status (and tag) column indicates a 
manufacturer listing that includes additional information about their 
products in the master note. 

Level (LVL): 
Text Level. The icons in this column graphically illustrate the hierarchy 
level of each paragraph. This column can be toggled off and on (the 
default position is On). 

Notes (N): 
An icon in this column indicates that a note is attached to the 
corresponding paragraph. The color and position of the icon indicates 
its source: yellow on the left is for master notes; blue on the right is for 
project notes. This column cannot be toggled off. 

 

Origin (O): 
This column indicates the origin of each paragraph. If no icon is 
present, the paragraph is part of the master text. User-edited 
paragraphs display a light blue icon on the button, user added 
paragraphs display a larger blue and white icon, and master 
paragraphs for which an alternative, user-edited paragraph exist 
display a yellow icon on the top (see Document Menu, Restore 
Paragraph from Master). This column cannot be toggled off. 

 Tags (T): 
This column displays the current tag for particular paragraph types. 
Tags link selected paragraphs to specific reports. The tags are 
abbreviations for various requirements. This column can be toggled 
on and off (the default position is Off). See Chapters 8 and 10 for 
more information on tags.  

 Document Links (DL): 
A Microsoft Word icon in this column indicates a link to an external 
Word document. Clicking on the icon opens the linked document in 
Word, provided the path associated with the link is still valid. This 
column can be toggled on and off (the default position is Off).  
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 Status (S): 
Status displays the current project condition of each paragraph in a 
status box. This column cannot be toggled off. 

The background color of the status columns indicates cursor location and active or inactive 
text status, as follows: 

Blue  Current cursor location. 

Light Gray Inactive (nonprinting text). If the status box indicates the paragraph 
has been selected, either manually or by a link, and the background 
of the status columns remains light gray, the parentage of the 
current paragraph is incomplete. All higher level text in the branch 
must be selected to include a selected lower level paragraph in the 
project. 

Dark Gray Active text. All text that will print as part of the project is indicated by 
a dark gray background in the status columns. 

Green Manufacturer listings that include additional information about their 
products in the master note are highlighted by green status (and 
tag) columns. 

Status Boxes 
The status of each paragraph in a section is visually displayed in the box in the Status 
column to the left of the text in the Document panel. The status of each section is visually 
displayed in the status box to the left of each document title in the Tree Panel. There are 
two types of status: 

User status reflects actions taken by the user 

Software status reflects links made by the software 

User Status 
User status is indicated by symbols in the foreground of the status boxes: 

Blank – If the foreground is blank, the user status is neutral 

Checkmark – A checkmark indicates a user status of selected 

X – An X indicates a user status of excluded 

NOTE: To change the user status, click in the status box. The first click results in a 
checkmark, the second an X, and the third returns to blank. 
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Software Status 
Software status is indicated by the background color and the shape of the status boxes: 

White or gray square – indicates a software status of neutral 

Green square – indicates a software status of selected 

Red stop sign – indicates a software status of excluded 

Yellow triangle – indicates a software status of highlighted or possible 

Active Vs. Inactive Text 
The status boxes display a combination of the user and software states. A user status of 
selected or excluded always overrides the software status. A user status of neutral allows 
the software status to determine whether or not the text is active. 

Active text is included in the project and will print. Inactive text will not print. The status box 
of active text will always have a checkmark, a green background, or both; and the status 
boxes of active text appear pressed in and more brightly colored than the status boxes of 
inactive text. 

The status box of an active section or paragraph will look like one of the following: 

 Selected by user (checkmark), neutral by system 

 Neutral by user, selected by system (green) 

 Selected by user (checkmark), selected by system (green) 

NOTE: The checkmark on the green box is actually redundant. It is not necessary to 
check a green status box in order for the paragraph to be active. 

 Selected by user (checkmark), highlighted by system (yellow triangle) 

NOTE: When a paragraph is recommended by the system, in order to make it active the 
user must put a checkmark in the triangle. 

 Selected by user (checkmark), excluded by system (red stop sign) 

NOTE: The system excludes conflicting options, but if for some reason both are needed, 
the user can override the exclusion by putting a checkmark in the stop sign. 

The status box of an inactive section or paragraph will look like one of the following: 

 Neutral by user, neutral by system 
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NOTE: To make the paragraph active click in the box. 

 Selected by user (checkmark), neutral by system 

NOTE: The gray background of the status box indicates that the paragraph is not active. 
Check the parentage of the paragraph. 

 Excluded by user (X), neutral by system 

NOTE: Exclude neutral paragraphs only to prevent subsequent links from including the 
paragraph 

 Neutral by user, highlighted by system (yellow triangle) 

NOTE: To make the paragraph active click in the triangle. 

 Excluded by user (X), highlighted by system (yellow triangle) 

NOTE: Exclude highlighted paragraphs only to prevent subsequent links from including 
the paragraph. 

 Neutral by user, excluded by system (red stop sign) 

NOTE: Override the system exclusion by clicking in the stop sign. 

 Excluded by user (X), selected by system (green box) 

NOTE: If a system selection is inappropriate, override it by clicking once in the box to get 
a checkmark, and clicking a second time to get an X. 

 Excluded by user (X), excluded by system (red stop sign) 

NOTE: The X on the red stop sign is redundant. 



 C h a p t e r  3  :  S o f t w a r e  O r i e n t a t i o n  

90 S p e c L i n k  U s e r  M a n u a l  

Navigation Techniques 
SpecLink provides alternative navigation techniques that allow you to use the software in 
the manner that is most comfortable for you. Choose the navigational techniques that work 
best for you.  

Recommended Navigational Strategies 
Tree Panel:  

• In the Tree panel, click on the status box to select, exclude, or deselect a section. 

• To open a section in the Document panel, click on the section title. 

• To open a second section in the same project, open another copy of the project by 
selecting New Window from the Window Menu, then select the desired section. Move 
back and forth between sections by selecting the appropriate window from the list on 
the Windows menu, or tile the two sections by selecting the appropriate command 
from the Windows Menu or using a toolbar button.  

• To move back and forth between open projects, choose the window you want from the 
list on the Window menu, or minimize the current window and expand the desired 
window. 

Within a Section:  

• Use the "Move to First" and “Move to Last” buttons on the Project Window toolbar to 
move quickly to the beginning and end of the section. 

• When text is fully expanded, use the “Previous at Current Level” and “Next at Current 
Level” buttons on the Project Window toolbar to move quickly between major headings 
or parts of a section. 

• Use the Mark Place and Return to Mark commands on the Document menu to return 
quickly to a particular location after moving elsewhere in the section. 

NOTE: The existing bookmark is replaced when you mark a different paragraph in a 
given section, or open another section in the Document panel. 

• Use expand/collapse to move quickly from one part of the section to another. Click the 
"Show Level" buttons on the Section Window Toolbar to expand or collapse text 
quickly. For example, if text is fully expanded and you are near the end of the section 
and you want to move to a paragraph under Part 1, first collapse the text by clicking the 
Show Level 1 button on the Project Window toolbar, then click on the paragraph Part 1 
General, then click on Show Level 2 to see the major headings below that part of the 
section. 
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• Use vertical scroll bar arrows to move through a section paragraph by paragraph. Click 
on the scroll bar to move one page at a time. Drag the scroll thumb to move through 
large portions of the section quickly. 

• Use the Page Down or Page Up keys on the keyboard to move quickly through a 
document. 

• Use Find to move quickly to a specific word, partial word, or phrase. 

Accessing and Using Help 
Help is right at your fingertips. There are several ways to access Help: 

F1 At any time press F1 to get help about an active window or menu. 

Help Button From the Toolbar, click the Help icon (the book with question mark) to open the 
SpecLink Help Window. 

Help Menu The Help menu displays the following options: 

Contents Displays the Help contents. From the Contents list, choose the 
topic closest to what you need. 

Use Index for Help 
On… 

Type or select from the list of topics. 

Search for Help On… Type a keyword to find it in all topics. 

Register SpecLink+ Opens Registration and Settings dialog box 

About SpecLink+ The About SpecLink+ information box opens. 

The SpecLink Help Window 
When you open the SpecLink Help Window, you gain access to the SpecLink help system. Help 
provides you with step-by-step instructions for the operations necessary to produce your 
documents. Help also includes content-related help—“How to Prepare Projects.” 
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SpecLink Help Topics Window 

When you click on one of the topics, you see either an additional information window or a 
larger reference window with detailed information about the topic. 

Within Help you can click on the Back button to retrace your steps through the Help 
window. You can click on the Index tab to display an alphabetized index of all available Help 
topics. You can also print the currently displayed Help topic. 

Technical Support  
For assistance in installing or using SpecLink: 

Hours: Monday through Friday - 8:30 to 5:30 EST 

Call: 800-266-7732 or 404-365-9226 in Atlanta 

Fax: 404-365-8912 

E-mail: support@bsdsoftlink.com 

Knowledge base: http://www.bsdsoftlink.com/support_qa/index.php 

 

 


